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Quick Start

The quickest way to get up and running in using PowerStar is to open the sample circuit files
provided with the installation. These are normally located in the Circuits folder under your
documents folder.
•

•
•

•

•
•
•

Familiarize yourself with the function of the toolbar buttons by slowly mousing over them,
noting the tool tips and watching the status bar messages. Do the same with the symbols
on the symbols panel.
Open a sample circuit. Mouse over the symbols and note the tool tips and status bar
messages.
If the circuit is not active, click on the calculate button . The meter panel should appear.
Mouse over the circuit diagram symbols and watch the data tips. Select a symbol and read
the meter panels and status bar.
Try moving individual lines and symbols by left clicking on them and dragging them to
different screen positions. Try copying them by holding down the [Ctrl] key and dragging
the symbols or lines to another position.
Add a new symbol by selecting a symbol from the symbols panel and dragging it to an
empty area on the screen.
Add a new line by mousing over a snap grid position until the cursor turns to a crosshair
icon. Left click and drag the cursor to the desired end point.
Double click on a symbol to bring up the properties panel. Modify the symbol data,
calculate the circuit and observe the effect on the electrical data.

If you encounter any difficulties doing any of the above, please refer to the appropriate
section of this help file.
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Using PowerStar

The use of PowerStar consists of three basic steps:
1. Drawing the circuit diagram.
2. Entering data for all symbols in the diagram.
3. Calculating the circuit.
Drawing the Circuit Diagram.
The circuit to be calculated can be any actual circuit consisting of standard electrical devices,
cables and equipment such as loads, generators, motors, etc. The circuit is represented by
drawing symbols and connecting lines on the screen. The result is a single line diagram.
To draw a symbol, click on a symbol on the symbols panel and drag the mouse cursor to the
desired position on the screen. Release the mouse button to draw the symbol.
Connecting lines are started by positioning the mouse cursor on a grid point where it turns
into a cross-hair cursor.Click and hold the left mouse button and move to the desired
endpoint. Note that lines may only be drawn between snap grid points. Snap grids may be
displayed by clicking on the Snap Grid Button .
Connecting lines may only be drawn as vertical or horizontal lines.When crossing over other
lines, the line being drawn automatically crosses over (no connection) the other line. To
cross-connect, terminate the line on the other line.
Selecting Symbols and Lines
Left click on any symbol or connecting line to select. Markers are used to show selections on
the circuit diagram. To select multiple lines and symbols, hold the [Shift] key while selecting
each symbol and line in turn.

Motor symbol with a marker. Horizontal connecting line with end markers.
Entering Data.
Data for all the symbols must be entered before circuit analysis may be performed. To enter
data for a symbol, double click on the symbol. This will activate the Properties Panel . Most
of the data entry fields in this form are required, although some, such as the Label and
Description fields are optional.
A helpful feature of PowerStar is the Database. By clicking on the
button in the Properties

Panel, a Database Box is activated. By selecting a record in the database, the data entry fields
on the properties panel are automatically filled in. Of course, some fields such as cable
lengths must still be filled in manually.
Another helpful feature is the
button. Clicking on this button will automatically fill in the
data entry fields with values from the last form edited and saved as default using the
button.
Calculation.
Calculation is started by selecting Circuit|Calculate from the menu or clicking on the
Calculate Button
on the Circuit Toolbar. This will start the analysis and error checking
process before proceeding with the calculation.
When the calculation is completed, the meter panel is displayed. Mouse-over any symbol to
show voltages, current kva, kw and power factor on a data tooltip box, or select a symbol or
connecting line to display data on the meter panel.
Display Result.
Electrical data can be displayed using the meter panel. Select any symbol by clicking it to
show voltages, current kva, kw and power factor on the meter panel. Hover the mouse on any
part of the circuit to show device info and electrical data in a data tip window.
A text report on the circuit can be displayed on screen. The report can be saved in rich text
format (RTF) or Microsoft Word Format (DOC) which can be read in Microsoft Word or
most other word processing software for further formatting and editing.
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Keyboard Shortcuts

Following are tables of keyboard shortcuts. Many of the shortcuts can speed up PowerStar
operations like zooming the circuit display.
Edit Operations
Menu
Copy
Cut
Paste
Undo
Delete

Keyboard
Ctrl+C
Ctrl+X
Ctrl+V
Alt+BkSp
Del

Common Operations
Menu
Circuit|Report
Circuit|Calculate
Device|Data
View|Grid
Help
Close Window

Keyboard
Ctrl+R
F8
Enter
Ctrl+G
F1
Alt+F4

Action
View circuit report
Calculate circuit.
Show device data
Toggle Grid display
Display help
Close current window

Zoom Operations
View Command
Zoom In
Zoom Out

Keyboard
[+]
[-]

Action
Increase screen magnification
Decrease magnification
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Action
Copy selected object to clipboard
Delete selected object and save to clipboard
Paste selected object from clipboard
Reverse the last operation
Deletes the selected object

Mouse Techniques

In addition to the standard functions of the mouse in Windows, there are several additional
functions of the mouse in PowerStar.
Device Information - Mouse over a symbol to display a tool tip with information such as
label, name, device class, connection. Clicking on a symbol will display information on the
Status Bar. A double click on the symbol activates Properties Panel that displays more
detailed information on the device.
Entering or Editing Data - A double click on the symbol activates Properties Panel for
filling in or editing ratings and other properties.
Drawing Symbols - Click on a symbol button on the symbols panel and drag the cursor to
the desired position on the screen. Note that the cursor changes to indicate the final symbol
position. Release the mouse button to add the symbol to the circuit diagram.
Drawing Connecting Lines - Clicking on a snap grid position and dragging the mouse
cursor across the screen produces a rubber banding line. Releasing the mouse button draws a
connecting line.
Selecting symbols and lines - Clicking on a symbol will select that symbol indicated by a
light grey rectangle enclosing the symbol. Clicking on a line will select that line indicated by
small black rectangular grab handles on both ends. Holding the shift key lets you select select
multiple symbols, lines and graphics objects.
Marking a Block - A selection box may be started by clicking anywhere away from snap
grid positions. Dragging the mouse across produces a rubber banding selection box.
Releasing the mouse button will select all the symbols, connecting lines and graphics objects
previously enclosed by the selection box..
Moving symbols and lines - Clicking on any selected symbol, line or graphics object and
dragging the mouse cursor across the screen before releasing the mouse button will move all
the selected symbols, lines and graphics objects to the new position. Note that symbols may
not be moved to a position that is already occupied by another symbol or line.
Duplicating symbols and lines - Pressing the [CONTROL] key while clicking on any
selected symbol, line or graphics object and dragging the mouse cursor across the screen
before releasing the mouse button will copy all the selected symbols, lines and graphics
objects to the new position. Note that symbols may not be copied to a position that is already
occupied by another symbol or line.
Middle mouse button - Click the middle mouse button to toggle between select (arrow
cursor) and pan mode(hand cursor). In pan mode, you can grab the circuit and move it around
the screen.

Mouse Wheel - When in pan mode, the mouse wheel serves as zoom in/zoom out control. In
select mode, scrolls screen up and down.
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File menu commands

The File menu offers the following commands:
New
Creates a new document.
Open
Opens an existing document.
Close
Closes an opened document.
Save
Saves an opened document using the same file name.
Save As
Saves an opened document to a specified file name.
Print
Prints a document.
Print Preview
Displays the document on the screen as it would appear printed.
Print Setup
Selects a printer and printer connection.
Send...
Sends the active document through electronic mail.
Exit
Exits PowerStar.

Edit menu commands

The Edit menu offers the following commands:
Undo
Reverse previous editing operation.
Cut
Deletes objects from the circuit and moves it to the clipboard.
Copy
Copies objects from the circuit to the clipboard.
Paste
Pastes objects from the clipboard into the circuit .
Delete
Deletes objects from the circuit.
Select All
Selects all connecting lines, symbols and graphics.
Default Settings
Opens settings box for PowerStar default settings.

View menu commands

The View menu offers the following commands:
Symbols
Shows or hides the symbols panel.
Meter Panel
Shows or hides the meter panel.
Properties
Shows or hides the properties panel.
Equipment List
Shows or hides the equipment, cables and devices list panel.
Status Bar
Shows or hides the status bar.
Toolbars
Shows or hides main, graphics and circuit toolbars
Grid
Shows or hides the snap grid.points
Zoom In
Zoom Out

Increase screen magnification.
Decrease screen magnification.

Circuit menu commands
The Circuit menu offers the following commands:
Calculate
Calculates the electrical circuit.
Report
Generates a text report for this circuit.
Symbol Set
Select another symbol set file.
Properties
Opens a circuit properties panel.

Symbol menu commands

The Symbol menu offers the following commands and applies to the selected symbol in the
circuit diagram:
Disconnect
Connects/Disconnects the selected symbol.
Invert
Invert symbol.head to tail
Rotate Clockwise
Rotate clockwise pivoting on the head point
Rotate Counterclockwise
Rotate counterclockwise pivoting on the head point
Properties
Opens properties settings panel.
Edit Symbol Graphics
Edit symbol by modifying the graphical object components of the symbol
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Graphics menu commands
The Graphics menu offers the following commands:
Select
Use selection tool.
Grabber
Use for screen pan and zoom
Line
Draw line tool.
Rectangle
Draw rectangle tool.
Round Rectangle
Draw rounded rectangle tool.
Ellipse
Draw ellipse tool.
Pie
Draw elliptical pie tool.
Arc
Draw elliptical arc tool.
Chord
Polygon
Polyline
Text
Arrange

Draw elliptical chord tool.
Draw polygon tool.
Draw polyline tool.
Draw text tool.
Group/un-group selections. Move selected graphics layer forward/backward.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this
application:
Help Contents
Opens the help viewer on the contents table.
Help Index
Offers you an index to topics on which you can get help.
Use Web Help
Offers choice of local copy or live web help.
Buy Now
Opens the default internet browser to the PowerStar products page.
Enter License Key
Opens an entry form for the activation key.
Check for Updates
Select to check for updates on demand or upon start up.
About

Displays the version number, license and other information about PowerStar

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple
views of multiple documents in the application window:
New Window
Creates a new window that views the same document.
Cascade
Arranges windows in an overlapped fashion.
Tile
Arranges windows in non-overlapped tiles.
Arrange Icons
Arranges icons of closed windows.

Toolbars
Use this command for instructions about using Help.

Main Toolbar

New File - create a new circuit file.
Open File - open an existing circuit file.
File Save - save the current circuit file.
Edit Cut - cut the selected object and save to Windows clipboard.
Edit Copy - copy the selected object and save to Windows clipboard.
Edit Paste - copy the saved object in Windows clipboard to the current circuit.
File Print - print the current circuit diagram.
Help About - display PowerStar copyright and version information.
Undo - undo the last operation.
Delete - delete the current selection.
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Circuit Toolbar

Symbols panel - show/hide symbols panel.
Meter panel- show/hide meter panel.
Properties panel - show/hide properties panel
Graphics toolbar - show/hide graphics toolbar.
Snap grids - show/hide snap grid points.
Zoom In - increase screen magnification.
Zoom out - decrease screen magnification.
Disconnect - disconnect the selected symbol from the circuit.
Invert - invert selected symbol head to tail.
Rotate clockwise - rotate selected symbol clockwise.
Rotate counter-clockwise - rotate selected symbol counter-clockwise.
Edit symbol - edit the component graphics of the selected symbol.
Calculate - Activate the circuit to show/hide electrical data/load flow.
Report - Create and display text report for the current circuit.
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Graphics Toolbar

Selection tool
Pan and zoom tool
Line
Rectangle
Rounded rectangle
Ellipse
Elliptical Arc
Elliptical Pie
Elliptic chord
Filled polygon
Polyline
Text
Move selection forward
Move selection backward
Move selection to front
Move selection to back
Group selection
Un-group selection
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Circuits

Circuit as used in PowerStar is a single line diagram representing a physical circuit. The
represented circuit may be a combination of balanced or unbalanced three phase or single
phase equipment and devices. There must be one and only one source (either a generator or a
source bus), connected to one or more loads.
All branches should preferably be terminated through a load , although PowerStar will still
correctly analyze the circuit as long as some of the branches are correctly terminated.
All devices in the circuit must be interconnected into one circuit, either through cables or
devices or through connecting lines. Two or more independent (not interconnected) circuits
are not allowed. Ring, looped, or meshed network connections are not allowed. The loop
must be open to be able to calculate the circuit.

Example of a circuit
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Equipment, Cables and Devices

Circuit components as used in PowerStar means any electrical equipment, cable or electrical
device. The component is represented in the circuit by a symbol. The component may be
balanced or unbalanced, linear, passive or active and must not be coupled either capacitively
or inductively with other component in the circuit. The symbol may be single-ended (3
terminals for three phase) such as generators, loads and motors or double ended(6 terminals)
e.g., cables and transformers, excluding the neutral.
All components have three optional properties, name, label and description . The label and
name may optionally be shown on the screen and on the circuit printout.
Circuit components are classified as follows:
GENERATOR
SOURCE BUS
CABLE
TRANSFORMER
SYNCHRONOUS MOTOR
INDUCTION MOTOR
POWER CAPACITOR
POWER REACTOR
IMPEDANCE
LOAD
DISTRIBUTION BOARD
PANELBOARD
MOTOR CONTROL CENTER
PROTECTIVE DEVICE
CONNECTION DEVICE
NULL DEVICE
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Symbols

A symbol drawn on the screen is a graphical representation of an electrical component equipment such as transformers, generators and motors or cables or other electrical devices.
A symbol has the following properties.
Component Class - indicates the classification of the electrical component.
GENERATOR
SOURCE BUS
CABLE
TRANSFORMER
SYNCHRONOUS MOTOR
INDUCTION MOTOR
POWER CAPACITOR
POWER REACTOR
IMPEDANCE
LOAD
DISTRIBUTION BOARD
PANELBOARD
MOTOR CONTROL CENTER
PROTECTIVE DEVICE
CONNECTION DEVICE
NULL DEVICE
Connection Type - Whether the symbol is connected to the circuit on its head or head and
tail. The connection is basically determined by the device class, for example, head-tail for
cables and transformers and head only for motors, generators and loads.
Phase Connection - The phases connected may be 3-phase, ABC, or 3-phase plus neutral,
ABCN. Single phase connections may be line-to-line, AB, BC, CA or line to neutral, AN, BN,
CN.
Connection Status - The normal status of a symbol is connected. It may be disconnected or
connected again by selecting it clicking the Disconnect Button . The symbol is grayed out
if it is disconnected.
Label - A symbol has a label that is shown below and to the right of the symbol on the circuit
display. This is also displayed on the Status Bar. When first inserted in the circuit, the label is
only a pre-set prefix (such as "T" for a transformer). When you start the calculation process,
PowerStar automatically numbers the symbols if the device auto-number option flag is
checked. The numbering sequence is left to right, top to bottom. For example, the top
leftmost transformer label will now be "T1". The device label may be repositioned by
clicking on the label and dragging it to the desired position . The label text may be edited in
the Properties Panel.
Position and Orientation - The symbol head is positioned on a snap grid point. It can be

rotated around this point using the rotate buttons
so that it points up, right, down or
left. The symbol may be inverted using the invert button
.
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Grids and Lines

Grids - All connecting lines and symbols are drawn between snap grids. The snap grids
points may be shown or hidden by toggling the Snap Grid Button .
Lines - Connecting lines are drawn by dragging the mouse cursor across the screen while
pressing the mouse left button. The line must be started by pressing the left mouse button on
a snap grid position. PowerStar uses the connecting lines to determine the connection
between the circuit components.
Note that graphical lines and other graphical elements are ignored by PowerStar when
analyzing and calculating the circuit.
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Abbreviations

I - Current, amps
Ipri - Current, Primary Winding
Isec - Current, Secondary Winding
i1 - Current at device head
i2 - Current at device tail
Ia, Ib, Ic - Line current
Irated - Rated Current
Ist/Ifl - Starting to Full Load Current Ratio
kA - Current, amps X 1000
kW - kilowatt
kVA - kilo-voltamps
kVAr - kilo-voltamps reactive
MVAsc - Short Circuit MVA
kAsc - Short Circuit Current X 1000 amps
R - resistance, ohms
R/km - unit resistance
V1 - voltage at device head
V2 - voltage at device tail
Vd - voltage drop, volts
Vpri - voltage, primary winding
Vsec - voltage, secondary winding
Van, Vbn, Vcn - Line to neutral voltage
Vab, Vbc, Vca - Line to line voltage
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Equipment, Cables and Devices

Circuit components as used in PowerStar means any electrical equipment, cable or electrical
device. The component is represented in the circuit by a symbol. The component may be
balanced or unbalanced, linear, passive or active and must not be coupled either capacitively
or inductively with other component in the circuit. The symbol may be single-ended (3
terminals for three phase) such as generators, loads and motors or double ended(6 terminals)
e.g., cables and transformers, excluding the neutral.
All components have three optional properties, name, label and description . The label and
name may optionally be shown on the screen and on the circuit printout.
Circuit components are classified as follows:
GENERATOR
SOURCE BUS
CABLE
TRANSFORMER
SYNCHRONOUS MOTOR
INDUCTION MOTOR
POWER CAPACITOR
POWER REACTOR
IMPEDANCE
LOAD
DISTRIBUTION BOARD
PANELBOARD
MOTOR CONTROL CENTER
PROTECTIVE DEVICE
CONNECTION DEVICE
NULL DEVICE
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Using the Symbols Panel

The Symbols Panel displays the symbols from a symbol set file which is opened by
PowerStar when it starts. You can set the default symbol set file by selecting Edit | Default
Settings... from the main menu.

Displaying the Panel - Use the symbols button

to show or hide the symbols panel.

Symbol Information - Mouse over any of the symbols to display a tool tip information on
the symbol component class or type.
Adding Symbol to Circuit - To add a symbol to the circuit diagram, click on the symbol and
drag the cursor to the desired grid location on the screen. Note that the cursor shape changes
to indicate the symbol orientation depending on the position of the cursor relative to the snap
grid point. Release the mouse button to add the symbol to the circuit diagram.
Adding Symbol from Circuit - To copy a symbol from a circuit to the symbols panel, right
click on the symbol and select Copy to Symbol Set on the menu. The copied symbol will be
added to the end of the symbol set. This function is useful for reusing a symbol that has been
edited from within PowerStar.
Editing the Symbols Panel - Right click on any symbol to display a menu which lets you
Cut, Copy, or Delete any symbol on the panel. Right click on any symbol position to display
a menu to Paste from the clipboard or Insert Blank on that position.
Move, Duplicate Symbols - To rearrange the symbols, click on any symbol and drag it to its
new position. To duplicate a symbol, press and hold the [CTRL] key while dragging a
symbol to its new position. A copy of the symbol will be left at the original position.
Saving the Symbol Set - If the symbol set was modified, PowerStar will give you the option
of saving it when you close PowerStar. You can save it under the original filename or under
another filename.
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Manipulating circuit symbols

Move a symbol - To move a symbol on the screen simply left click on the symbol and drag it
to the new position. Release the button to position the symbol on the closest snap grid point.
Note that you can not move a symbol over another symbol or line.
Move a group of symbols - To move a group of symbols, connecting lines and graphics
objects, select the group. Left click and hold the mouse button on the upper left corner of the
desired area. Drag the cursor across until the rubber-banding square encloses the symbols to
be selected. Release the mouse button to select all the symbols, connecting lines and graphics
inside the selection area. Alternatively, select a group of symbols by holding the [SHIFT] key
while clicking on the symbols to be selected in turn.
Next, left click on any selected object and drag the mouse cursor across the screen until the
symbols are positioned over the desired area. Release the mouse button to complete the
move. Note that you can not move a symbol over another symbol or line.
Rotate a symbol - Each symbol can be individually rotated around its head point using the
clockwise button
or the counter-clockwise button
. It can also be inverted head to tail
using the invert button
.
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Drawing connecting lines

Connecting lines (as opposed to graphics lines) are used to indicate connections between
symbols. PowerStar uses the connecting lines to analyze the circuit configuration. Graphical
lines and other graphical objects are ignored by PowerStar when calculating circuits.
To draw connecting lines, position the mouse cursor over a snap grid point. The mouse cursor
will turn to crosshair icon when positioned properly over a snap grid point.To show the grid
points, click on the snap grid button
on the Circuit Toolbar.
Press and hold the left mouse button and drag the cursor across the screen. A rubber banding
line will show where the line will be drawn. Release the mouse button when the desired
direction and length of the line are shown.
When adding new connecting lines, the lines will automatically cross over intersected lines
without connecting to those lines, unless one line ends or starts on any section of the other
line. The intersected line will be broken up at the intersection point into two sections.
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Copying and pasting symbols and blocks of symbols

To duplicate a symbol in a circuit, press and hold the [Ctrl] key, left click the center of the
symbol and drag the cursor to the desired position before releasing the mouse button.
To duplicate a block of symbols, the symbols must first be selected using a square selection
area. To do this, click and hold the mouse button on the upper left corner of the desired area.
Drag the cursor to the opposite corner until the desired block size is shown. Releasing the
mouse button will select all the symbols, connecting lines and graphics objects inside the
selection area. Another way to select multiple symbols is by holding the [SHIFT] button
while clicking on each symbol to be selected in turn.
Next, press and hold the [Ctrl] key, left click on any selected object and drag the mouse
cursor across the screen until the symbols are positioned over the desired area. Release the
mouse button to complete the operation.
Note that when copying or duplicating symbols or blocks of symbols, the symbol properties,
including the device data are copied over to the new symbols. Note also that the symbol or
symbols to be copied must not overwrite any existing connecting line or symbol. Otherwise,
the copy operation will fail.
To copy the selected symbols, lines and graphics objects to Windows clipboard, click on the
Copy Button on the main toolbar. or choose Edit|Copy from the menu bar.
Symbols previously saved to Windows clipboard may be pasted in any vacant area on the
screen. To start paste operation, click on the Paste Button. The cursor changes to a paste
cursor. Position the cursor over the insertion point (top left corner of the block to be pasted)
and click the mouse left button.
Note that the symbol or symbols to be pasted must not overwrite any existing connecting line
or symbol. Otherwise, the paste operation will fail.
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Positioning Symbol Labels

To position a symbol label, click on the label and drag the cursor to the desired position
before releasing the mouse button. Note that the label text may not be modified by double
clicking. To edit the symbol label text, open the Properties Panel by double clicking on the
symbol.
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Disconnect Button
The Disconnect Button
disconnects the selected symbol or symbols from the circuit. If the
circuit is not active (has not been calculated), you will need to disconnect all lines and
symbols downstream of the selected. If the circuit is active, connecting or disconnecting a
symbol correspondingly connects or disconnects all symbols and connecting lines
downstream of that symbol and recalculates the circuit.

Disconnecting Breaker A14 disconnects all symbols and lines connecting to distribution
boards D9-D12
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Equipment, Cables and Devices List Panel

The list panel displays in tabbed pages, a list of each equipment class and a summary of
individual class and quantities.The lists are sorted alphabetically to assist in searching for
individual items.
Click on any item on the list to select it. The corresponding symbol on the circuit diagram
will then be displayed with a marker. Double click an item in the list to select the
corresponding symbol in the circuit as well as opening the properties panel for that symbol.
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Properties Panel

The Properties Panel is mainly a form for displaying and editing various properties of circuit
components such as symbols and connecting lines, graphical objects, circuit defaults and
PowerStar settings.

Legend:
1
Save Button
Save any changes to the properties form.
2
Database
Opens the Database for help in filling up data form.
3
Copy Default
Copies stored data from the last saved default form into the
current form.
4
Save To Default
Saves data from the current form as default for future use.
5
Basic Properties
Common to all circuit components - Label, ID, Description
fields.
6
Connection
Phase or line or three-phase connection, connection status,
transformer winding configuration.
7
Option Properties
Show/hide options and other options such as data units.
8
Data
Depending on component class, displays ratings and other
properties.
9
Description
Displays a summary or short description of the field being
edited.
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Default Settings

The default settings for PowerStar can be displayed and edited in the properties panel by
selecting Edit|Default Settings from the main menu.
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Circuit Properties

The properties panel displays the circuit properties for the current circuit if there are no
selected symbols, graphics or connecting lines. Double click on an empty space on the
diagram to display the properties panel.
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Common Properties

The properties panel form for equipment, cable and devices have common data entry fields
grouped as follows:

Basic
Label - Should not be left blank. Label text will be drawn as part of the symbol.
ID - Optional additional identifier.
Description - Optional description will be included in the circuit report.

Connection
Phase Connection - Select from AN, BN, CN, AB, BC, CA, ABC, ABCN.
Disconnected - Set to True to exclude from circuit calculation.

Option
Depending on the classification of the symbol, one or more of the following options may be
displayed:
• Show Label - Option to draw the label text as part of the symbol.
• Show Device Name - Option to draw the ID text below the label text.
• Voltage units - volts or kV
• Primary voltage units - volts or kV
• Secondary voltage units - volts or kV
• Current units - Amps or kAmps
• Apparent power units - kVA or MVA
• Real power units. - kW or MW
• Reactive power units - kVAr or MVAr
• Motor output units - HP or kW
• Length units - kFeet or km
• Transmission line length units - miles or km.
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Equipment, Cables and Devices Database

The database can be used to fill in the properties form with recorded preset values. Click
[Copy Data] button to fill the properties panel form with values from the database.
Database Buttons:
Copy Text - Check this to copy the data record type into the device description field in the
properties panel.
Clone- Create a new record using the the current selected record data values. Record type will
be "New Data Record".
Edit Type- Edit the data record Type/Size field.
Delete - Delete the selected data record. This action can not be undone.
Copy Data- Use the record values to fill in the properties panel data form.
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Source Bus Data

About Source Bus - In many cases a source bus is used instead of a generator when only a
section of a larger system is the scope of the project.
Voltage rating - the no load voltage of this bus source.
Short circuit MVA - the estimated or calculated short circuit capacity of this bus.
R/X ratio - the internal resistance to reactance ratio.
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Cable Data

About Cables - All conductors with non-negligible impedances should be included in the
circuit. This includes all types of cables, bus bars, bus ducts, distribution lines. Neutral
conductor impedances are assumed to be zero. If the neutral impedance is not negligible and
the load is unbalanced 3-phase, the calculation will show a higher load voltage and higher
load current than the actual. For single phase loads fed by 2-core cables, make sure to include
the impedance for line and neutral conductors in entering the per linear unit impedances.
R, ohms/linear unit - the cable resistance per 1000 linear unit for each phase. Note that this
value is temperature dependent.
X, ohms/linear unit - the cable reactance per 1000 linear unit for each phase. The neutral
impedance is assumed to be zero.
Temperature rise - the temperature above the reference temperature where the conductor
impedance was measured.
Length in linear unit - the cable length.
Rated current in amps - the rated ampacity of the cable. Note that this dependent on
temperature and installation configuration.
Sets in parallel - number of cable sets in parallel. Cable sizes and installation configuration
must be identical.
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Capacitor Data

About Capacitors - Capacitors refer to power factor correction capacitors or capacitor banks
which are connected across phases or between phases and neutral. For series capacitors, use
impedance device class with a negative reactance and zero resistance.
Voltage in volts - Operating voltage of the capacitor bank/assembly.
Rated capacity in kVAr - rated kilovar capacity of the capacitor bank/assembly.
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Distribution Board Data
About Distribution Boards - Similar to panelboards and motor control centers,
distribution boards are special types of loads consisting of several sub-loads connected
together by a bus bar. This simplifies the circuit representation and also relieve the user the
need to calculate the total kVA and power factor of the assembly. To edit the sub-loads,
click the button on the number of branches field to display a data form.

Right click any line to display the editor menu. Left click on any field to edit the field value.
Click [OK] to save. PowerStar will automatically calculate the
total load and power factor.
The properties panel displays the following:
Load is balanced - Not editable. Setting dependent on number of branches.
Voltage rating - Operating voltage of the DB.
Rated Power - The total load kVA of this DB.Not editable. Value dependent on number of
branches.
Load P.F. - The net load power factor of this DB.Not editable. Value dependent on number
of branches.
Number of Branches - the number of branches for this DB.Not editable. Click the field button
to edit the circuit branch details as shown above.
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Generator Data

About Generators - PowerStar treats generators as perfect voltage sources (infinite bus). To
simulate voltage regulation, insert an impedance in series with values consistent with r/x ratio
and voltage regulation.
Voltage rating - No-load voltage of the generator.
Rated capacity - rated capacity of the generator.
R/X ratio - Resistance to reactance ratio. Ignored in calculations.
Voltage Regulation % - the difference between no load and full load voltage divided by full
load voltage in percent. Ignored in calculations
Copyright © 2009-2017 Megasys Software

Impedance Data

About Impedance Devices - These devices are included as a general purpose substitute for
any other electrical component not covered by the other classification.
Resistance, ohms - the actual device resistance in ohms.
Reactance, ohms - the actual device reactance in ohms.
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Motor Data

About Induction/Synchronous Motors - Both type of motors are treated as constant
impedance load instead of the more realistic constant kVA. This means the current draw
decreases with lower voltages instead of increasing to maintain power as in actual motors.
Voltage rating - Operating voltage of the motor.
Rated power - Enter the motor shaft output rating.
Motor P.F. - Enter the actual motor operating power factor.
Efficiency, percent - the mechanical efficiency of the motor. As a guide, about 80% at
3.75kW(5HP) and 90% at 37.5(50HP).
Start-Full Load Ratio - the ratio of starting current to the full loads current. Between 1.5-15,
typically 6.5.
Running/Starting - Select operating mode of motor.
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Load Data

About Loads - Loads represents any power sink This could be an electrical equipment, group
of equipment, or an electrical distribution network.
Voltage rating - Operating voltage of the load.
Load power rating - Specify the operating kVA/MVA of this load.
Load power factor - Enter the load operating power factor.
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Motor Control Center

About Motor Control Centers - Similar to distribution boards and panelboards, motor
control centers are special types of loads consisting of several sub-loads connected together
by a bus bar. This simplifies the circuit representation and also relieves the user the need to
calculate the total kVA and power factor of the assembly. To edit the sub-loads, click the
button on the number of branches field to display a data form.
Load is balanced - Not editable. Setting dependent on motor control units.
Voltage rating - Operating voltage of the MCC.
Rated Power - The total load kVA of this MCC.Not editable. Value dependent on motor
control units.
Load P.F. - The net load power factor of this MCC.Not editable. Value dependent on motor
control units.
Number of Motor Control Units - the number of motor control units for this MCC.Not
editable. Click the field button to edit the motor control units.
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Panelboard
About Panelboards - Similar to distribution boards and motor control centers, panelboards
are special types of loads consisting of several sub-loads connected together by a bus bar.
This simplifies the circuit representation and also relieves the user the need to calculate the
total kVA and power factor of the assembly. To edit the sub-loads, click the button on the
number of branches field to display a data form.
Load is balanced - Not editable. Setting dependent on number of branches.
Voltage rating - Operating voltage of the PB.
Rated Power - The total load kVA of this PB.Not editable. Value dependent on number of
branches.
Load P.F. - The net load power factor of this PB.Not editable. Value dependent on number of
branches.
Number of Branches - the number of branches for this PB.Not editable. Click the field button
to edit the circuit branch details.

Protective Device Data

About Protective Devices - Note that all data are optional and not used during calculation.
The trip current will indicate warning if exceeded in the calculation.
Type - Select fuse, air circuit breaker or oil circuit breaker.
Voltage rating - rated voltage of the device.
Frame Size - the frame size in amps.
Trip Current - the current setting of the trip element of the device.
Interrupting Rating - the maximum current the device can safely break.
Momentary Rating - the maximum current the device can safely withstand.
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Transformer Data

About transformers - PowerStar includes voltage transformation and phase shift in
calculating circuits. Delta-Wye windings shifts the secondary voltage by -60
degrees(delayed) while Wye-Delta shifts the secondary 60 degrees(advanced). Zigzag
windings are treated as Wye. For example, a Wye-Zigzag winding is the same as a Wye-Wye
winding. In PowerStar , winding types only affect the phase shift between windings.
Rated Capacity - Enter transformer capacity rating.
Primary voltage - Operating voltage, primary.
Secondary voltage - Operating voltage, secondary.
Winding Tap - Select primary or secondary tap location. Note that for primary, positive tap
setting lowers secondary voltage. The opposite is true for secondary taps.
Winding Tap % - Percentage tap setting.
Resistance % - Percent of base impedance, resistance.
Reactance % - Percent of base impedance, reactance.
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Connection Device
This circuit component class represent electrical equipment and devices connected inline but
with no impedance and no effect on the circuit calculations. Examples are switches, bus bar
with negligible impedance, ammeter or current transformers.

Null device
Null devices are a circuit component class with negligible conductance and no effect on
circuit calculation. This class include voltmeters, PTs and lightning arresters.

Meter Panel
The meter panel displays the electrical data of any part of the electrical circuit. Click on any
symbol or connecting line to select it and display the calculated electrical data on that part of
the single line diagram.

Legend:
1

Vector Button

2

Scalar Button

3

Polar Format Button

4

Rectangular Format

5

Vector Display

6

Voltage Data

7
8

Current Data
Power Data

9

Arrows
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Toggles voltage vector display between line to line and line to
neutral (if neutral is available).
Displays voltage and current values in magnitude only, example
276.257.
Displays voltage and current values in polar coordinates with
angles in degrees, example 276.257 <85.169.
Displays voltage and current values in rectangular format,
example 236.257 +j145.67.
Draws the voltage and current vectors. Angle is zero for
horizontal line to the right. Counterclockwise is positive.
Displays line to line voltage and line to neutral voltage (if
neutral is available).
Displays line currents and neutral if available.
Displays apparent, real, reactive power and power factor as
calculated at the head end of the symbol.
Arrows shows the direction of real and reactive power flows

Data Tip Box

The data tip box is similar to the tool tip that appears when the mouse hovers over a toolbar
button.
Hover the mouse over any symbol or connecting line on an active circuit to display
information and electrical data, such as label, name, voltages, current, kVA, kilowatt and
kilovar flow.
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Circuit Report

Circuit report is available if the circuit is active. PowerStar creates a report file with a
filename report.rtf to disk and subsequently displays it in a dialog box or in Windows
WordPad. To save this file for future reference, save it under another filename.
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Graphics Elements
Graphics elements do not affect the circuit calculation but are useful for complementing the
presentation of the circuit diagram.
Graphics elements can be used to:
·
annotate the circuit diagram
·
graphically modify individual symbols
·
add captions
·
create nameplates
·
show borders
·
delineate circuit sections
The following graphical elements are provided:
·
line
·
rectangle
·
rounded rectangle
·
ellipse
·
elliptical arc
·
elliptical pie
·
elliptical chord
·
polygon
·
polyline
·
text
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Graphics Operations
Before creating or manipulating any graphics, click on the
tool-bar button to hide the snap
grids, unless you want the graphics to be sized and located on the snap grid points.
Operations - Graphics objects, like symbols and connecting lines can be moved, deleted,
cloned and used with Windows clipboard operations. They can also be sized.
Create New - To create a graphics object, select the desired shape from the toolbar buttons,
left click on the top left corner and drag the cursor to the bottom right to the approximate
size. For polygons and polylines, double click the last vertex to complete the
polyline/polygon.
Selecting Objects - To select a graphics object, click on the inside if it is solidly filled or on
the outline if not. Selecting a graphics object creates grab handles for that object, which can
be clicked and dragged to resize the object.
Layers - All graphics objects will be layered such that the newer objects will display on top
of older objects. A selected object can be moved towards the front or back by using the
following tool-bar buttons,
.
Multiple Selection - To select several objects, press and hold the [Shift] key and left click on
individual objects. To select objects within an area, left click on the top left of the area and
drag the rubber banding selection rectangle to the bottom right. Release the mouse button to
create a selection area. All objects inside the area will be selected.
Group/Ungroup - Several graphics object can be grouped together to form a single object.
To do this, select the objects as above, then click the
tool-bar button. To ungroup the
objects, click the
button.
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Graphics Properties

Basic Properties - All graphics objects have the following basic properties:
Line Type - May be solid, none, or a combination of dots and dashes.
Line Width - Normal line width is zero which is 1 pixel wide.
Line color - Click on the data entry field to show the button used to activate the color
selection box.
Fill Type - May be solid, none, or a combination of patterns.
Fill Color - Click on the data entry field to show the button used to activate the color
selection box.
Text - For text graphics, font, justify and text content may be edited by clicking the ellipsis
button at the end of the entry field..
Elliptical Objects - For elliptical graphics, zero degrees is +x axis (3:00 o'clock), positive is
counter-clockwise. The graphics starts at the start angle and moves counter-clockwise
towards the end angle.
Rounded Rectangles - For rounded corner rectangles, the X and Y axis roundness refers to
the relevant radii of the ellipse quadrant used to form the rounded corners of the rectangle.
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Feedback

For any questions, comments, or suggestions, please contact our technical support service at:
support@megasyssoftware.com
While describing the problems you have found in PowerStar, please provide us with the
following information:
· PowerStar Build Number. Preferred - screen capture of Help/About Box.
· Your Windows version.
· Sequence of your actions that caused the problem.
· As many details related to the problem as possible.
Before requesting technical support, please make sure you are using the latest version of
PowerStar . Information on the latest releases can be found on the Web site at:
www.megasyssoftware.com
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Upgrades

If you are a registered user of PowerStar, you have the right for free upgrades to any newer
minor version (for example, from 1.0 to any 1.x version). Or, you have the right for free
upgrades to any newer major version (for example, from 1.x to 2.x, 3.x, 4.x, and so on) in
case if the period of one year since your order date has not yet elapsed.
In other cases, you have the right for a 50% discount from our current price for an upgrade to
any newer major version of PowerStar.
For more information about recent releases, please visit our Web site at:
www.megasyssoftware.com
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How To Order

You can order PowerStar online through our secure website.Your payment will be processed
by payment service provider PayPal. You do not need to be a member of PayPal, they will
process Visa or Mastercard and accept payments in different currencies (US Dollar,
Australian Dollar, Euro, Pound Sterling, Canadian Dollar, etc).
Once your order is complete, your license key will be immediately sent via email to unlock
the software for use.
The final cost for PowerStar depends on what type of license and how many copies of that
license you are ordering. The latest pricing information is available on our Web site.
The quickest way to order is by selecting Help/Buy Now from the PowerStar menu. Or you
can simply visit the Megasys Software web page and place your order:
https://www.megasyssoftware.com/products.php
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License Key

As soon as your order for PowerStar is complete, you will receive a license key, which
should be entered into the program to unlock it for use.
To apply your license key:
1. Select the license key in your order confirmation e-mail, and press Ctrl+C to copy it to the
Clipboard.
2. Run PowerStar.
3. Choose Help|Enter License Key from the menu.
4. In the dialog-box, click the Paste button to insert your license key.
5. Click the OK button and then restart PowerStar.
You are strongly advised to save your order confirmation e-mail for future reference.
Please do not distribute your license key and do not let anybody copy it. Otherwise, as stated
in the license agreement, if your key is published anywhere, your license for using PowerStar
will be terminated.
Lost your key?
If, for any reason, you have lost your license key, just contact us and we will resend it to the
e-mail address you used when registering.
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